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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between Broadvox and Avaya IP Office R9.0.

Broadvox SIP Trunking provides PSTN access via a SIP trunk between the enterprise and the
Broadvox network as an alternative to legacy analog or digital trunks. This approach generally
results in lower cost for the enterprise.

Broadvox is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between Broadvox and Avaya IP Office R9.0.

In the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office 500V2
running Release 9.0 software, Avaya Voicemail Pro messaging application, Avaya H.323 and SIP
hard phones, and SIP-based Avaya softphones.

The Broadvox SIP Trunking service provides PSTN access via a SIP trunk between the business site
and the Broadvox network as an alternative to legacy analog or digital trunks. This approach
generally results in lower cost for the enterprise.

2. General Test Approach and Test Results

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to the Broadvox SIP Trunking service via the public Internet. This configuration (shown in
Figure 1) was used to exercise the features and functionality tests listed in Section 2.1.

2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered during
the compliance test.

e SIP OPTIONS queries and responses.

¢ Incoming PSTN calls to H.323 and SIP telephones at the business site. All inbound PSTN
calls were routed to the business site across the SIP trunk from the service provider.

e  Qutgoing PSTN calls from H.323 and SIP telephones at the business site. All outbound
PSTN calls were routed from the business site across the SIP trunk to the service provider.

e Various call types including: local, long distance, outbound toll-free, international, and

directory assistance.

G.711MU and G.729A codecs.

Caller ID presentation and Caller ID restriction.

DTMF transmission using RFC 2833.

Voicemail access and navigation for inbound and outbound calls.

Telephony supplementary features such as hold and resume, transfer, and conference.

Off-net call forwarding and call transfer/conference.

Twinning to PSTN mobile phones on inbound calls.

Use of SIP INVITE message for call redirection to the PSTN.
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Inbound and outbound long-duration calls stability.

Inbound and outbound long hold time call stability.

Response to incomplete call attempts and trunk busy or error conditions.
T.38 fax.

Items not supported or not tested include the following:

¢ Inbound toll-free and emergency calls (911) were not tested as part of the compliance test.

¢ Broadvox SIP Trunking does not support Operator (0) or Operator-Assisted (0 + 10-digits)
calls.

¢ Broadvox SIP Trunking does not support use of the SIP REFER method for network
redirection (transferring calls with the PSTN back to the PSTN).

2.2. Test Results

Interoperability compliance testing of Broadvox SIP Trunking was completed with successful results
for all test cases with the exception of the observations/limitations described below.

e OPTIONS - Broadvox SIP Trunking is configured not to send OPTIONS to the business
sites.

¢ Codec Lockdown on Outbound Calls — When Avaya IP Office was configured with
multiple codecs, Broadvox responded to the outbound INVITE sometimes with the single
codec as preferred by IP Office (first in the offered codec list), but sometimes with the same
multiple codecs in the SDP instead of selecting the first one from the INVITE SDP list. This
behavior had no user impact. Calls were successful using the first offered codec.

e T.38 Interworking with G.729 Codec — Broadvox treats T.38 faxing interworking with
G.729 as best effort attempt with no guarantee for success. In the compliance test, this was
not an issue. Avaya IP Office was configured to offer G.711MU as the preferred codec (as
recommended by Broadvox) as did Broadvox, therefore T.38 faxing always interworked
with G.711 as verified by the compliance test.

¢ Direct Media — Avaya IP Office R9.0 offers a new Direct Media capability on IP Office
500V2 that allows IP endpoints to send RTP media directly to each other rather than having
all the media flow through the IP Office, using up VoIP and relay resources. This capability
is not supported on the configuration described in these application notes where the Avaya
IP Office connects to the service provider network via a direct public Internet connection
without using an enterprise Session Border Controller.

2.3. Support

Customer and technical support for Broadvox SIP Trunking can be reached at

e  Phone number: (888) 849-9608
o Email: customerservice @broadvox.com and technicalsupport@broadvox.com

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)
provides access to overall sales and service support menus.
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3. Reference Configuration

Figure 1 illustrates the test configuration showing a business site connected to Broadvox SIP
Trunking.

Located at the business site is an Avaya IP Office 5S00V2. Endpoints include various Avaya IP
Telephones (with H.323 and SIP firmware) and SIP-based Avaya softphones (Avaya IP Office
Softphone and Avaya Flare® Experience for Windows). The site also has a Windows PC running
Avaya Voicemail Pro for providing voice messaging service to the Avaya IP Office users, and
Avaya IP Office Manager for administering the Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user
phones will also ring and can be answered at the configured mobile phones.
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Figure 1: Test Configuration

For security purposes, any actual public IP addresses used in the compliance test were changed to
192.168.x.x throughout these Application Notes.
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For the purposes of the compliance test, users dialed a prefix digit 8 or 9 plus N digits to send an
outbound call to the number N across the SIP trunk to Broadvox. The short code of 8 or 9 was
stripped off by Avaya IP Office but the remaining N digits were sent to the service provider network.
For calls within the North American Numbering Plan (NANP), the user dialed 11 (1 + 10) digits for
long distance calls and local calls. Thus, for these NANP calls, Avaya IP Office sent 11 digits in the
Request URI and the To header of an outbound SIP INVITE message. Broadvox sent 10 digits in
the Request URI and the To header of inbound SIP INVITE messages.

In an actual customer configuration, the business site may also include additional network
components between the service provider and Avaya IP Office such as a session border controller or
data firewall. A complete discussion of the configuration of these devices is beyond the scope of
these Application Notes. However, it should be noted that SIP and RTP traffic between the service
provider and Avaya IP Office must be allowed to pass through these devices.

4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment / Software Release / Version
Avaya IP Office 500V2 9.0.0.0 Build 829
Avaya IP Office COMBO6210/ATM4 9.0.0.0 Build 829
Module
Avaya IP Office Manager 9.0.0.0 Build 829
Avaya Voicemail Pro 9.0.0.311

Avaya 1616 IP Telephones (H.323)

Avaya one-X Deskphone 1.3 SP3

Avaya 9611G IP Telephones (H.323)

Avaya one-X Deskphone 6.3

Avaya 9630G IP Telephones (H.323)

Avaya one-X Deskphone 3.2

Avaya 1120E IP Telephone (SIP) 4.03.18.00
Avaya 1140E IP Telephone (SIP) 4.03.18.00
Avaya IP Office Softphone 3.2.3.49 68975
Avaya Flare® Experience for Windows 1.1.4.23

Broadvox Co

mponents

Equipment / Software

Release / Version

Broadvox Fusion

1.2.13
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5. Configure Avaya IP Office

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From the PC
running Avaya IP Office Manager, select Start - Programs - IP Office > Manager to launch
the application. A screen that includes the following in the center may be displayed.

WELCOME to IP Office Administration

What would you like to do ?

Create an Offline Configuration

Cipen Configuration from Svsterm

Fead a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the configuration
may be alternatively opened by navigating to File - Open Configuration at the top menu of the
Avaya IP Office Manager window. Select the proper Avaya IP Office system from the pop-up
window and log in with the appropriate credentials.

The appearance of the IP Office Manager can be customized using the View menu. In the screens
presented in this document, the View menu was configured to show the Navigation pane on the left
side, omit the Group pane in the center, and show the Details pane on the right side. Since the
Group Pane has been omitted, its content is shown as submenus in the Navigation pane. These
panes (Navigation and Details) will be referenced throughout the Avaya IP Office configuration.

All licensing and feature configuration that is not directly related to the interface with the service
provider (such as twinning and IP Office Softphone support) is assumed to already be in place.

In the sample configuration, Jersey City was used as the system name. All navigation described in
the following sections (e.g., License = SIP Trunk Channels) appears as submenus underneath the
system name Jersey City in the Navigation Pane. The configuration screens only highlight
values/settings configured for the compliance test. Defaults were used for other values and may be
customized based upon requirements in the field.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require Avaya IP Office to be
licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact an
authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in the
Navigation pane. Confirm a valid license with sufficient Instances (trunk channels) in the Details
pane. The screen below also shows the valid license for Avaya IP endpoints.

i Avaya I[P Office R Manager Jersey City [9.0.0.829] [Administrator{Administrator]]

File  Edit Wiew Tools  Help

IP Offices

- & BOOTP (2)
Operator (3]

AEElyv - 2\

License | Remote Server |

k- X v|<]|>

Jersey City | Feature License Key Instances Status ] A_j
3 System (1) | AUDI Yoicemail 255 Walid
7 Lina (8) | WMPro Metworked Messaging o - 255 Walid
! | ¥MPro Database Interface 255 Walid
<= Control Unit (2) | WMPra VB Script e Valid
Extension (16] | wMPro Recordings Administrators 255 Yalid
§ usergis | ¥MPro Outlook Interface 255 Walid
[+ i Group (1) | MPro TTS (Scansoft) 285 Walid
[ @ Short Code (65) | W¥MPro TTS (Genetic) 255 Walid
§oeo Eraccie Resoni = Vi
1 ok R.C\SQ) Report Wigwer 255 Walid
- @) Incoming Call Route (15) | Mability Features 255 Obsolete
€2 WanPort (0 | IPSO00 Yaice Metwarking Channels =t Walid
am Directory (0) | IPS00 Yoice Networking Channels - 4 Walid
£ Time Profile (0) | wCM Channel Migration - 255 valid
ol @. Firewall Profile (1) | [SIP Trunk Channels i 255 ‘u'alid:l
- [l 1P Route (4) | | IPS00 Universal PRI (Additional chan... 255 Walid :
& Account Code (0 | R&3 LRQ Support (Rapid Response) 255 Walid
- | IP Office Dealer Support - Standard E... 255 Walid
| IP Office Dealer Suppart - Profession. .. 255 Walid
&l Turinel (0) | 1P OFfice Distributor Support - Standa... 255 Yalid
£ ﬁ-; User Rights (&) | IP Office Distributor Suppart - Profes. .. 255 Walid
[ ARS (2] | UMS ‘Web Services 255 Walid
@ RAS Location Request (0) | CRSUP 235 Valid
#8 Location (09 | Custome.r Service Agent 255 \.-'al!d
| CCR Designer 255 Walid —_
| CCR CCCUPG - 255 Walid
| 1600 Seties Phones 1 255 Yalid
| Third Party APT 255 Walid
| one-# Portal far IP Office 255 Walid
| [evaya IP endpaints 255 Valid |
| | Enskamer Service Snarvisar #E5 Walid Aot | ]|
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To view the physical hardware comprising the Avaya IP Office system, expand the components
under the Control Unit in the Navigation pane. In the sample configuration, the second component
listed is a Combination Card. This module has 6 digital station ports, two analog extension ports, 4
analog trunk ports and 10 VCM channels. The VCM is a Voice Compression Module supporting
VolIP codecs. An Avaya IP Office hardware configuration with a VCM component is necessary to

support SIP trunking.

To view the details of the component, select the component in the Navigation pane.

The screen below shows the details of the IP 500 V2:

IP Offices B8 IP 500 V2 ef

R BOCTP (2)
47 Operator (3}

=79 Line (8]
(=)= Conkral Unit (2)

<y 2 COMBOBZ10/ATME
[+ Extension (16)
- User (18)
-8 Group (1)
-8 Short Code (65)
@ Service (0)
- ol RAS (1)
E3 @ Incoming Call Rouke (19)
E8 wanPart (0}
s Directory (0)
ﬂ',‘\ Time Profile {0}
- Firewall Profils (1)
=] IF Route (4]
g Account Code (0)
&, License (64)

| Uit |

| X | w|<]>

Drevice Mumber

Lnit Type

Wersion

Serial Mumber

Unit IP Address
Interconnect Murmber

Module Mumber

|1

|1P 500 ¥z

|9.0.0.829

|10.32.128.30

|a

[control Uit

The screen below shows the details of the Combination Card:

E COMBOB210/ATMA )

IP Offices

@& BOOTR(2)
:’3:'-] 1 Operator (3)
Eu iy Jersey City
[#-#2p Syskem (1)
[T Line (8]
(== Control Unit {2}
feszp 1 IR SO0 VE

[#--4fr Extension {16)
[-f User (18)
& a Group (1)
[+ @ sShort Code (65)
6B Service (0
iy RAS (1)
[#- @ Incorming Call Route {19)
@ WanPort (0)
wm Directory ()
17 Time Prafile (0)
& @ Firewall Profile (1)
28 IF Route (4]
- Account Code (0)

Uniik |

| X1 v <]

Device Mumber
Unit Type
Wersion

Serial Mumber

Unit IP Address

Interconnect Mumber

Madule Murber

e, License (64)

2

[comBoezioimme

|9,0,0,829

o

[contral Uit
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5.2. System

This section configures the necessary system settings.

5.2.1. LAN2 Tab

In the sample configuration, Jersey City was used as the system name and the WAN port (LAN2
port) was used to connect the Avaya IP Office to the public network. The LAN?2 settings correspond
to the WAN interface on Avaya IP Office. To access the LAN2 settings, first navigate to System =>
Jersey City in the Navigation Pane and then navigate to the LAN2-> LAN Settings tab in the
Details Pane. Set the IP Address field to the IP address assigned to the Avaya IP Office WAN port.
Set the IP Mask field to the mask used on the public network.

IP Offices ﬁ Jersey City” £ N llalli=

BOOTP (22 ) System | LAM1 | LANZ | DNS || woicemail | Telephony | Directory Services | System Events | SMTP | SMDR || Twinning | WM | CCR | Codecs
Operator (3 Il & Il el Il I Il Il Il Il I 1 {0
Jersey City | LAM Settings | voIP | Metwork Topology | )
oyl IP Address [192 . 168 . 96 . 231 |
iy Jersey City L i
T Line (6) IF Mask, |2z55 . 255 | 255, 128 |
= Contraol Unit {23 | — — —
Ay Extension (16) Frimary Trans. IP Address | @ i} i} 0|
& User (18} ) — T =
i Group (1) RO (EHONES )
[ @% Short Code (55) RIP Mode Mone w
@ Service (0) Y —=
s RAS (1) [] Enable MaT

[

@ Incoming Call Route (193
Eﬂ WanPort (0}

amw Directory (00 DHCP Mode

{'“ T?me Proflle FD) O server (O Client () Dialin (%) Disabled Advanced
@9 Firewall Profile (1)

Bl 1P Route (4)

g Account Code (0}

W, License (64)

& Tunnel (00

i User Rights (8}

¢ ARS (2)

" RAS Location Request {0}
& Location (0}

Mumber OF DHCP IP Addresses 200 3|

[

[
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On the VoIP tab of LAN?2 in the Details Pane, check the SIP Trunks Enable box to enable the
configuration of SIP trunks.

In the RTP area:

e The RTP Port Number Range can be customized to a specific range of receive ports for the
RTP media. Based on this setting, Avaya IP Office would request RTP media be sent to a
port in the configurable range for calls using LAN2.

¢ In the Keepalives section. Select RTP for Scope; select Enabled for Initial keepalives; enter
30 for Periodic timeout. These settings direct Avaya IP Office to send artificial RTP
packets toward the service provider at the start of the call to prevent audio loss in certain off-
net call redirection scenarios. Some service providers expect the IP Office endpoint to send
RTP packets first even though there is no IP Office media endpoint involved in this call
situation since the call has been re-directed back to the PSTN.

6 -
= Jersey City £ | X | v < |
| Swskem || LANT | Lanz |oms | voicemai Telephony | Directory Services | System Events | SMTP || SMOR | Twinning | ¥CM || CCR || Codecs
|| Lan Settings | ¥oIP | Metwaork Topalogy
=
H3#3 Gatekeeper Enable
[] Auto-create Extn Auto-create Lser [ H323 Remote Extn Enable
| SIP Trunks Enable
SIP Registrar Enable
[] auto-create ExtnjUser [] 1P Remote Extn Enable
Cramnain Mame
DR UDF Port 5060 3| PRemoteuDPRort |
Layer 4 Prokocol TP TCP Port (5060 5| Remate TCPPort |0
Ol ms TLSPort (5061 S| Remote TLS Part
Challenge Expiry Time (secs) 1@ =
RTF
Port Mumber Range
Minimum #9182 L Madimum Bazde o
Port Mumber Range (MAT)
Miniirrirn ;49152 | Faximurn [pazde 3|
Enable RTCP Monitoring on Port 5005
Keepalives
Scope ;RTP | Petiodic timeout ;30
Initial keepalives ?Enabled b
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Scroll down to the DiffServ Settings section. Avaya IP Office can be configured to mark the
Differentiated Services Code Point (DSCP) in the IP header with specific values to support Quality
of Services policies for both signaling and media. The DSCP field is the value used for media and
the SIG DSCP is the value used for signaling.

= Jersey City £ | X | & | < |
| System || LaM1 | Lanz | DMS | Moicemail | Telephony | Directory Services | System Events | SMTP | SMDR || Twinning | ¥oM || ccR | Codecs
L&M Settings | WoIP ENetwork Topaology |
Enable RTCP Monitoring on Port 5005 %
Keepalives
| == -}
Scope |RTP VI Petiodic tirmeout |30
Initial keepalives | Enabled w :
DifFSery Settings
B8 2| DscRite) B8 3| wideoDSCR(Hey FC 3 | DSCPMask(Hex) (88 2| SIG DSCP (Hex)
46 |3 pscp 46 % viden DSCP & 2| Dscpmask 34 3| sIGDsCP
DHCP Settings
Primary Site Specific Option Nurmber (S50 176 B :
—————x
Secondary Site Specific Spkion Mumber (550M) 242 e
)
WLAN Mok Present bt
1100 Yoice YLAM Site Specific Option Mumber (550K (232 - .
1100 Yoice YLAN IDs |
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On the Network Topology tab of LAN2 in the Details Pane, configure the following parameters:

¢ For Firewall/NAT Type, select a setting from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With the
Open Internet setting, STUN Server IP Address is not used.

¢ Set Binding Refresh Time (seconds) to a desired value. This value is used as one input to
determine the frequency at which Avaya IP Office will send SIP OPTIONS messages to the
service provider. See Section 5.9 for complete details.

e Set Public IP Address to the IP address of the Avaya IP Office WAN port.

¢ Set Public Port to 5060 for UDP.

[

F Jersey City” £ [ 0w =

System | LAMI | Lanz |oms | voicemail Telephony | Direckory Services | System Events | SMTP | SMDR | Twinning || ¥CM || CCR | Codecs
LAN Settings | woIP | Metwork Topology |

Metwork Topology Discovery

STUN Server Address §§'_3.?q._1§33_. 13 STUN Part ?_'34?8 | c
Firewal/MAT Type E:E_Z)pen Internet ¥
Binding Refresh Time (seconds) :%U -CI
Public TP Address 192 . 168 . 95 . 231 Cancel
Public Port
UDP E-SDE-D 3'.
TP D $|

L

TLS

|:| Run STUM on skarbup

During the compliance testing, the LAN1 interface was used to connect the Avaya IP Office to the
enterprise site [P network. The LANT1 interface configuration is not directly relevant to the interface
with Broadvox, and therefore is not described in these Application Notes.
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5.2.2. Voicemail Settings

In the Voicemail tab of the Details Pane, configure the SIP Settings section. The SIP Name and
Contact are set to one of the DID numbers assigned to the enterprise from Broadvox. The SIP Display
Name (Alias) parameter can optionally be configured with a descriptive name. Uncheck the Anonymous
box to allow the Voicemail Caller ID information to be sent to the network.

= Jersey City £ | K| v < |

System | LAN1 | LANZ || DNS Yoicemai Telephory | Direckory Services | Syskem Events | SMTP | SMDR || Twinning | YiCM CCR Codecs

‘Yoicemail Tvpe |voicemail LitefPro “ '

|:| Messages Butkon Goes Ta Visual Yaice

Vaicemail Destination

Voicemail IP Address 10 3z 128 78 |

Backup Voicemail IP Address | 0 ] 0 a}

Woicemail Channel Reservation

Unreserved Channels  |237

LA

Auto-Atkendant 2 & Voice Recording 5 | . Mandatary Yoice Recording |5

I; 7| s [ |
Announcements |2 % | Maibox Access |3 =l

DTMF Ereakout

Reception | Breakaut (OTMF 00 b

Breakout (DTMF 23 | Bt |

Breakout (DTMF 3)

SIP Setkings
SIP Marme |7329624490

SIF Display Mame (Alias) :Voicemail
Contact [7329624490

Anonyrmaous |:|
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5.2.3. System Telephony Settings

Navigate to the Telephony = Telephony tab on the Details Pane. Enter or select 0 for Hold
Timeout (secs) so that calls on hold will not time out. Choose the Companding Law typical for the
business site. For the compliance test, U-LAW was used. Uncheck the Inhibit Off-Switch
Forward/Transfer box to allow call forwarding and call transfer to the PSTN via the service
provider across the SIP trunk per customer business policies.

= Jersey City £ | ® | v | = |

Swsktem | LAML | LAMNZ || DNS Yoicemail | Telephorey Directory Services | System Events | SMTP | SMDR. | Twinning | WCM CCR Codecs

Telephony | park & Page | Tones & Music | Ring Tores | sm Call Log | TUI

=
Analogue Extensions Companding Law |
T i Swiikch Line
Default Qutside Call Sequence | Mormal “ |
Diefault Inside Call Sequence ?Ring Tvpe 1 | © UHLaw © U-Law Line
Defaulk Ring Back Sequence i-F-!iru; Tvpe 2 w
s ] ) Alaw ) A-Law Line
Restrict Analogue Extension Ringer Yolkage Ll
Dial Delay Time (secs) 4 =l [ 035 status
Dial Delay Count 2 | Lt
Default Mo Answer Time (secs) 515 = Dial By Name
e I | Show Account Code
1 w |
B ¢ (secs) Gog =] | [ tnhibit Off-Switch Forward] Transfer |
ark Timeout {secs | - |
Ring Delay (secs) 5 4 [[] Restrick Metwork Interconnect
ing Delay (secs | - |
— < [] orop External Only Impromptu Conferance
Zall Priarity Pramokion Time (secs) §D|55b|ﬁd 3 |
i — isually Differentiate External Ca
[] wisually Differentiate External Call
Default Currency | s “
2 = [ unsupervised analog Trunk Disconnect Handling
Default Mame Priority | Favor Trunk, b
. : High Cuality Conferencing
Media Connection Preserwvation | Disabled G |
! [] strict 51P5
Digitalianalogue Auko Create User i
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5.2.4. Twinning Calling Party Settings

To view or change the System Twinning settings, navigate to the Twinning tab in the Details Pane
as shown in the following screen. The Send original calling party information for Mobile

Twinning box is not checked in the sample configuration, and the Calling party information for
Mobile Twinning is left blank.

i

= Jersey City = | |« | <

Systern | LAML | LAMNZ | DMNS Woicemail | Telephony | Direckory Services | Systemn Events | stTe | SMDR | Twinming |'v'CM CCR | Codecs

[1 send original calling party information for Mobile Twinning

Zalling party infarmation For ]
Mabile Twinning | |

5.2.5. System Codecs Settings

In the Codecs tab of the Details Pane, select or enter 101 for RFC2833 Default Payload. This setting
was recommended by Broadvox for use with out-band DTMF tone transmissions.

=

i= Jersey City &5 e |

gSystem LAM1 | LANZ | DNS ‘oicemail | Telephony | Direckory Services | Swsten Events | smTe || sMDR Twinning || YCM CCR 'CDdEC5|

— 1
RFC2633 Defaulk Payload (101 el

*|

Available Codecs Default Codec Selection
Unused Selected

[[#] 5711 LLAw Aak =G 7L LAWY 64K
[[¥] =711 ALaw GeK gG.?ll(AI:;.C\W B4k
| |G, 729(a) 8K C5-ACELP
II:‘ 3,722 B4 15, 723.1 6K3 MP-MLO
5,729(a) 8K C5-ACELP B
[[#] .723.1 6K3 MP-MLQ

Br
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5.3. IP Route

Navigate to IP Route - 0.0.0.0 in the left Navigation Pane if a default route already exists.
Otherwise, to create the default route, right-click on IP Route and select New. Create/verify a
default route with the following parameters:

e Set IP Address and IP Mask to 0.0.0.0.

e Set Gateway IP Address to the IP address of the gateway for the public internet WAN
network.

e Set Destination to LAN2 from the drop-down list.

IP Offices B 0.0.0.0 ek -MI X v

w- R BOOTR(2) | PRoute |
[#-¢% Operator (3) —
[=-%a Jersey Cby IP Address [ 0 il
w5y System (1)
T4 ne®)
<z Contral Unit {2) Gakeway IP Address | 135 10 a5 254 |
: f E)s(:n(il;)n i Pestinationy [Lanz |
& @ Group {13 Mekric ID E-l
- @% short Code (66) L |
@ Service (0) [ Prowey aRP
il RAS (1)
(£} @ Incoming Call Route (21)
@ WanPort {00
s Directary (0)
{T‘ Timne Profile (0}
&3] @ Firewall Profile (1)
=] IP Raute (4)

TP Mask [0 0.

EA 10.32.0.0

Bl 19z.168.0.0

192,168,99.0
& Account Code ()
@, License (64)
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5.4. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the Broadvox SIP
Trunking service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the
template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e [P addresses

e SIP Credentials (if applicable)

e SIP URI entries

e Setting of the Use Network Topology Info field on the Transport tab

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Sections 5.4.2 — 5.4.7.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls
e Transport — Second Explicit DNS Server
e SIP Credentials — Registration Required

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation Pane
and select New => SIP Line. Then, follow the steps outlined in Sections 5.4.2 — 5.4.7.

5.4.1. Create SIP Line From Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to US_Broadvox_SIPTrunk.xml. The file name is important in locating the
proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File = Preferences. In the IP Office Manager Preferences window that appears,
select the Visual Preferences tab. Verify that the box is checked next to Enable Template
Options. Click OK.

i# IP Office Manager Preferences @E]

Preferences | Directories | Discovery | Visual Preferences | Securiby | validation

Icon Size | Small w
Multiline Tabs
Enable Template Options

D [ o [ coea ][ v |

AMC; Reviewed: Solution & Interoperability Test Lab Application Notes 18 of 39
SPOC 12/29/2013 ©2013 Avaya Inc. All Rights Reserved. BrdvxSipTrkIPO9



3. Import the template into IP Office Manager. From IP Office Manager, select Tools =
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step S. The default template location is C:\Program Files\Avaya\IP
Office\Manager\Templates.

i Avaya IP Office RS Manager Jersey City [9.0.0.82%] [Admin

File  Edit Miew | Tools | Help

R E | :='| Extension Renumber .,
Line Renumber. ..
" om —
Connect Ta...
= & BOOTR(2 -
+ ‘F (2 Export » E‘I::I"'IDIF
- Cperator (3)
=3 Jersey Ciby SCM Service User Management
[#-5%p Syskem (1) T
& Busy on Held Yalidation
<= Control Unit MSM Configuration
[+ Extension (1
g User (18)
i Group (1) Irnport Templates in Manager
[+ @ Short Code (557 Fational Prefix
@ Service (D)
[ -aify RAS (1) Counkry Cade

In the pop-up window (not shown) that appears, select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window (not
shown) will appear stating success or failure. Click OK (not shown) to continue. If
preferred, this step may be skipped if the template file is copied directly to the IP Office
template directory.

AMC; Reviewed: Solution & Interoperability Test Lab Application Notes 19 of 39
SPOC 12/29/2013 ©2013 Avaya Inc. All Rights Reserved. BrdvxSipTrkIPO9



4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New - New SIP Trunk From Template.

IP Offices

SIP Line -Line 17

-6

Fl
LN
™

]

L R R e

e

[#
#

=2

BOCTPR (2

¢ Qperator (3)

| 5IF Line |Transport | SIP URL| ValP | T38 Fax| SIP Credentials

&g Account Code (0)

W License (64)

] i
. Ler:szﬂ L] Mew r H323 Line
T4 :‘] Generate SIP Trunk Template IP DECT Line |
ot SIP Line
A Exl | Cut Chrl+ e
& Ust 59 Copy Chrl+C ]
G . SIP DECT Line |
L sk
RS it Mew SIP Trumk From Template “
{3 sef 2 Delete Ctrl+Del —|
o RA 0 yalidate ! |
ﬂb Indg N 1N - B
% i |
a4 Dir Mew From Template (Binar — e
70 Tin Bl _ ¥ |Diversian Header V_I
@ Fir Export as Template (Binary) =
; T RSSOTAOTT TeTET T |B‘;.-' Source IP address |
: IP Route (4] Bt

5. In the subsequent Template Type Selection pop-up window, select United States from the
Country pull-down menu and select Broadvox from the Service Provider pull-down menu
as shown below. These values correspond to parts of the file name
(US_Broadvox_SIPTrunk.xml) created in Step 1. Click Create new SIP Trunk to finish
creating the trunk.

"] Template Type Selection

Locale

Country

."Ll nited States

=1

=

|

w | [ Display &

[ Create new SIP Trunk ] ’ Cancel ]

Note that the newly created SIP Line may not immediately appear in the Navigation pane
until the configuration was saved, closed and reopened in IP Office Manager.

shown in Sections 5.4.2 — 5.4.7.
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5.4.2. SIP Line - SIP Line Tab

In the SIP Line tab of the Details Pane, configure the parameters as shown below.

¢ Set ITSP Domain Name to the LAN2 IP address (192.168.96.231) so that Avaya IP Office
uses this IP as the URI host in SIP headers such as From and Diversion.

¢ Check the In Service box.

e Check OOS box. Avaya IP Office will use the SIP OPTIONS method to periodically check
the SIP Line. See Section 5.9 for details on time between SIP OPTIONS sent by IP Office.

¢ Set Call Routing Method to Request URI. Avaya IP Office will route inbound calls based
on the number in the Request URIL.

e Set Send Caller ID to Diversion Header. With this setting and the related configuration in
Section 5.2.4, Avaya IP Office will include the Diversion Header for calls that are forwarded
or redirected via Mobile Twinning out the SIP Line to the service provider.

¢ Uncheck REFER Support. Broadvox SIP Trunking does not supports use of REFER for off-
net call re-direction as in call transfer.

[ ]

Set Method for Session Refresh to Auto. With this setting Avaya IP Office will send
UPDATE messages for session refresh if the other party supports UPDATE. If UPDATE is
not supported, re-INVITE messages are sent.

IP Offices Ei

@& BOOTR(2)

SIP Line - Line 17°

| SIP Line [Transport|SIP URI| valP | T38 Fax SIP Credentials

gh-EI X<l

Operatar {3} o N
a3y Jersey City Line Mumber |17 = |
Systern (1) - — r
=17 Line (8) [c7sP Domain Neme 192.165.96.231 | [nservice |
11 P y
iie URI Type __SIP _v
143 ; [ 1
] Prefix | Check 005
714 I | _
.y, 17 Mational Prefix |Ca|| Routing Method Request URT v
., 15
- . COriginator number For I
=% Contro! Uit (2) Country Code forwarded and twinning calls |
Ay Extension (16) . —
i User (1) International Prefix Marne Pricrity | System Defaulk |
+- 53§ Group (1)
[£-B¢ Short Code (65) | Send Caller I Diversion Header v | Caller ID From From header  []
@ service (0) Association Method By Source IP address = Send From In Clear ]
[ RAS (1)

(£} e Incoming Call Route (19)

Eﬁ WanPork (0}

s Directory (00

{r.ﬁ Time Prafile {00

@ Firewall Profile {1)

BB IF Route (4)

g Account Code (0)

e License (64)

% Tunnel {0}

(£ g-; User Rights ()

- BRS (2)
' RAS Location Request (0}
{8 Location (0)

[

[] REFER Support

| Method For Session Refresh Auka

Session Timer (seconds) Cir Diernand

Media Connection Preservation | Disabled

User-Agent and Server
Headers
Service Busy Response 486 - Busy Here

Action on CAC Location Limit | allow Yoicemail
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5.4.3. SIP Line — Transport Tab
Navigate to the Transport tab and set the following:

e Set the ITSP Proxy Address to the IP address of the service provider SIP Trunking access
interface provided by Broadvox.

e Set the Layer 4 Protocol to UDP.
Set Use Network Topology Info to LAN2 as configured in Section 5.2.1.

[ ]
o Set the Send Port to 5060.

SIP Line - Line 17° e - X[ wvl<]|>
(SIP Line, Transport |SIP LRI |VolP | T3 Fax |SIP Credentials
IT5P Proxy Address |192.168.192.52 I

Mebwork Configuration

Layer 4 Prokocal iUDP v/ Send Port =F505'3 3 :

Use Metwork Topalogy Info |L.0.N 2 w | [
Explict DHS Server(s) | O ] i o || o 0 0 0|
Calls Route via Registrar
Separate Regiskrar
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5.4.4. SIP Line - SIP Credentials Tab

SIP Credentials are used to register the SIP Trunk with a service provider that requires SIP Registration.
The parameters below were used to register the SIP Trunk with Broadvox. SIP Credentials are unique per
customer and therefore customers must contact Broadvox to obtain the proper registration credentials for
their deployment.

Select the SIP Credentials tab, click the Add button and the New Channel area will appear at the
bottom of the pane. To edit an existing entry, click an entry in the list at the top, and click the Edit
button. The screen below shows a previously configured entry being edited. The entry was created with
the parameters shown below:

e Set the User name, Authentication Name, and Contact fields to the registration string provided
by Broadvox. This is generally a 10-digit telephone number like 7329624489 as shown below.

¢ In the Password field, enter the registration password provided by Broadvox.
¢ In the Expiry (mins) field, enter the time in minutes until the registration expires.

e Check the Registration required field if Registration is required for the Broadvox SIP Trunking
account, as was the case with the compliance test.

i - . i
= SIP Line -Line 17 e~ X v =]
SIF Line| Transport| SIP URI [ YaIP | 138 Fax| SIP Credentials |
Index | UserMame Authentication Mame  Contact Expiry {mins) = Register | add...
1 FIZ9624459 7320624459 FIZG24489 60 True
Remave
Edit...

Edit SIP Credentials

Liser name Fazacz448a _
Authentication Name 7329624489 :

Contart (7329624489

S [Fr—————
Expiry {mins) 60 3
Reqistration required
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5.4.5. SIP Line — SIP URI Tab

Select the SIP URI tab to create a SIP URI entry or edit an existing entry. A SIP URI entry matches
each incoming number that Avaya IP Office will accept on this line. Click the Add button and the
New Channel area will appear at the bottom of the pane. For the compliance test, a single SIP URI
entry was created to match any DID number assigned to Avaya IP Office users. The following
screen shows the edit window on a previously configured entry for the compliance test.

e Set Local URI to Use Internal Data. This setting allows calls on this line whose SIP URI
matches the SIP Name set on the SIP tab of any User as shown in Section 5.6.

e Set Contact and Display Name to Use Internal Data. This setting will cause the Contact
and Display Name data to be set from the corresponding fields on the SIP tab of the
individual User as shown in Section 5.66.

e Set PAI to Use Internal Data. This setting directs Avaya IP Office to send the PAI (P-
Asserted-Identity) header when appropriate. The PAI header will be populated from the data
set in the SIP tab of the call initiating User as shown in Section 5.66.

e Select the Registration value that was configured in Section 5.4.4.

® Associate this line with an incoming line group by entering line group number in the
Incoming Group field. This line group number will be used in defining incoming call routes
for this line. Similarly, associate the line to an outgoing line group using the QOutgoing
Group field. For the compliance test, the incoming and outgoing group 17 was specified.

e Set Max Calls per Channel to the number of simultaneous SIP calls allowed using this SIP
URI pattern.

SIP Line - Line 17* oD i A

SIP Line | Transport| SIP URT yoIP | T38 Fax| SIP Credentials

| channel Groups Wia  Local URI  Contact  Display Mame | PAI add. ..
1 17 17 i
Remaove
Edit...
Edit Channel
:
Via ;135.10.96.231
Local URI |
Contact ;;_Ise Internal Data v.
Display Mame [Use Internal Data w
Pal %Llse Internal Data v-;
Reqgistration 11 7329624489 w
Incoming Group ;1?
Cutgoing Group |17
Max Calls per Channel 1o =
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5.4.6. SIP Line - VoIP Tab

Select the VoIP tab to set the Voice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below.

¢ Set the Codec Selection to Custom.

e Choose G.711 ULAW 64K and G.729(a) 8K CS-ACELP from the Unused box and move
these 2 selections to the Selected box. These 2 codecs are supported by Broadvox SIP
Trunking. Use the down/up arrows to order the 2 selected codecs as shown. Broadvox
recommends G.711MU as the preferred codec.

e Select T38 for Fax Transport Support.

¢ Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones as out-band RTP events as per RFC2833.

Uncheck the VoIP Silence Suppression option box.

¢ Check the Re-invite Supported option box.

Check the PRACK/100rel Supported option box. This setting enables support by Avaya IP
Office for the PRACK (Provisional Reliable Acknowledgement) message on SIP trunks.

W — . . i
= SIP Line - Line 17 k- [ X vl<]|=
SIP Line | Transport | SIP URI| YoIP 735 Fax| SIP Credentials|
| ||:| YoIP Silence Suppression I
Allow Direct Media Path
- —
| Codec Selection 5Cust0m | | e —— |
Unused Selected
[G.711 ALAW 64K | as || [&711 OLAw sdk [ Codec Lockdown
| | G.723.1 6K3 MP-MLO | G.725(a) 8K CS-ACELP I PRACK/ 100rel Supported I
Farce direct media with phones
<< G.711 Fax ECAN
el
|Fa>< Transport Support ilTSEE ~ ||
Location i Cloud W |
Call Initiation Timeout {53 |4 = .
|DTMF Support iRFC2833 W ||
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5.4.7. SIP Line — T.38 Fax Tab

Select the T38 Fax tab to set the Fax over Internet Protocol parameters of the SIP line. Set the

parameters as shown below.

Uncheck Use Default Values at the bottom of the screen.

e Set T38 Fax Version to 0. Broadvox SIP Trunking supports T.38 fax version O.
Set Max Bit Rate (bps) to 14400, the highest fax bit rate that Avaya IP Office supports for

T.38 faxing.
¢ Check the Disable T30 ECM option.

= SIP Line - Line 17
SIP Line Transport s1P URI vorP |38 Fax [SIP Credenti
| | T35 Fax Yersion iEl -v_é |
Scan Line Fix-up
AN TFOP Enhancement
RELAIAEE — [[] Disable T30 ECM
ines D ";:l [] pisable EFlags Far First DIS
High Speed o _3,! [] pisable T30 MR Campression
TCF Methad i.'i'-rans TR r [ nsF Cverride
WMax Bit Rate (bps) | 14400 v |
EFlag Start Timer (msecs) ;25'39 2 | L —
EFlag Stop Timer {msecs) :230—0 _3:
Tx Metwork Timeout (secs) :_2'30 = _:

||:| Use Default Yalues

g-E [ X[v]=z]>
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5.5. Short Code

Define a short code to route outbound calls to the SIP line. To create a short code, right-click on
Short Code in the Navigation Pane and select New (not shown). In the Details Pane, configure the
parameters as shown below:

¢ In the Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. The 9N; short code, used for the compliance test, will be invoked when the user dials
9 followed by any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N”@192.168.192.82”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The IP address following the @ sign is the IP address of the
Broadvox SIP Trunking access interface.

e Set the Line Group Id to the Outgoing Group number defined on the SIP URI tab on the
SIP Line in Section 5.4.5. This short code will use this line group when placing the
outbound calls.

IP Offices

®- % BOOTR (2) | shart Code |
[H-4# Operator {3}

e -8 X vl

i Jersey City Code :_QN;
; ’?jist;en:sgj City el IDlal il v

¥ T Line (8] Telephone Number  |[N'®192.168.192 52"
(- Conkrol Unik (2) — =
[#- 4 Extension {16) Line Graup ID :1? |
@ User (18) — = —
@ % Group (1) Locale _Unlted States (U5 English) ¥
(2R L Short Code (66) Farce Account Code [

@ Service (0)
iy RAS (1)

) Incoming Call Route (21}
@ WanPort {0}
s Directory (0)
f:.“ Time Profile {0}

)-8 Firewal Profile (1)

i+ [l IP Route (4)
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The simple 9N; short code illustrated above does not provide a means of alternate routing if the
configured SIP Line is out of service or temporarily not responding. When alternate routing options
and/or more customized analysis of the dialed digits following the short code are desired, the Automatic
Route Selection (ARS) feature may be used. In the screen below, the short code 8N; is illustrated for
access to ARS. When the Avaya IP Office user dials 8 plus any number N, rather than being directed to a
specific Line Group Id, the call is directed to 50: Main, configurable via ARS. See Section 5.8 for
example ARS route configuration.

E 8N;: Dial e - [ X | v <=

Short Code [

Code iBN H

Feature !Dial W

Telephone Mumber [N |
|
|

Line Group ID ;SEI: Main |

Locale |

Force Account Code [

Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N; is illustrated. This short code is similar to the 9N; short
code except that the Telephone Number field begins with the letter W, which means “withhold the
outgoing calling line identification™. In the case of the compliance test, when a user dialed *67 plus
the number, Avaya IP Office would include the user’s telephone number (DID number assigned to
the user) in the P-Asserted-Identity (PAI) header and would include the Privacy: id header in the
outbound INVITE message. Broadvox would allow the call due to the presence of a valid DID in
the PAI header, but would prevent presentation of the caller id to the called PSTN destination.

*67N;: Dial" gf - X v <>
Short Code |
Code i;E-?NJ |
Feature !_Dllal V_|

Telephone Number  |WH'@192,186.2,12" |

Line Graup ID |17 |

Locale v |

Farce Account Code |:|
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5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP Line
configured in Section 5.4. To configure these settings, first navigate to User->Name in the
Navigation Pane, where Name is the name of the user to be modified. In the example below, the
name of the user is Jim 1120E. Select the SIP tab in the Details Pane. The SIP Name and Contact
are set to one of the DID numbers assigned to the enterprise by Broadvox. The SIP Display Name
(Alias) can optionally be configured with a descriptive text string. The value entered for the
Contact field will be used in the Contact header for outgoing SIP INVITE to the service provider.
The value entered for the SIP Name is used as the user part of the SIP URI in the From header for
outgoing SIP trunk calls.

If outbound calls involving this user and a SIP Line should be considered private, then the
Anonymous box may be checked to withhold the user’s information from the network (or
alternatively use the *67 short code as defined in Section 5.5).

IP Offices B Jim 1120E: 258 g M X vi<]|>

- % BOOTR (2) v
+ Operakor (3)
=59 Jersey City
=5 System (1) SIP Hame 7328891980
i Jersey City S ——
-1 Line (6) SIF Display Name (Alias) |Jim 1120E
= Cankrol Unit (2) >
& Extension (16) Contact |7328891980
= & User (18}
g Molser
; RemaoteManager
§ 251 Allan 9630
$ =zo01Extnzol
§ =202Extnzoz
203 Extnz03
204 Extnz04

User | Woicemail | DND | Short Codes | Source Numbers | Telephony | Forwarding || Dial In || Yoice Recording | Button Programming

Menu Programming || Mobilicy | Group Membership Announcements: SIP | Personal Directory

|:| Anorymous

205 Extn205
§ 2veExtnzos
§ =207 Extnzo?
208 Extn208

7 253 John Softphone
& 259 Juan FlareWin
ke 257 Taili 1140E
254 Tim

256 Tany 9611

£ ﬁ Group (1)

+- 8% Short Code (66)

The following screen shows the similar SIP settings for an analog extension user for fax:

E Extn208: 208 k- X v |<]>

User || Woicemaill | DND | Shork Codes | Source Mumbers || Telephony | Forwarding || Dial In || Yoice Recording | Button Programming

Menu Programming || Mobility || Group Membership | Announcements | SIP | Personal Directary
SIP Name 7328891993
SIP Display Mame (alias) |Extnz08

Corkack 7328891983

|:| Anonymous
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5.7. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, right-click Incoming Call Route in the Navigation Pane and select New (not
shown). On the Standard tab of the Details Pane, enter the parameters as shown below:

e Set the Bearer Capacity to Any Voice.
e Set the Line Group Id to the Incoming Group of the SIP Line defined in Section 5.4.5.

¢ Set the Incoming Number to the incoming DID number on which this route should match.
Matching is right to left.

IP Offices

- & BOOTR (2)
44 Operakor (3)

@ 17 18459997032
@ 17 6477761211
@ 17 6477761212
@ 17 6477761213
@ 17 6477761214
P 17 6477761215

@ 17 7328891982
P 17 7326891983

Standard | Yoice Recording | Destinations

E 17 7328891980 ef-E X vl

=1 1

Jersey Ciky = —
w5y System (1) Bearer Capability | Ay Yoice |
9 Line (8) ) ;-'- = ==,
<= Control Unit (2) Rnedronp D K7 28
< Extension {16) Tncoming kurber | 7328591980
@ User(18) L
5§ Group (1) Incoming Sub Address
-8 Short Code (66) )
@ Service (0) Incoming CLI | |
t' ol RAS q) Locale ;United States {US English) |
= @ Incoming Call Route (21) L = ;
@1 Priarity |1 - Low |
@0 Tag :
17 1234567590 'R e ||
g 17 18459997030 Hold Music Source | Syrstem Source i
@ 17 18459997031 Ring Tone Overtide |Mone |

On the Destinations tab, select the destination from the pull-down list of the Destination field. In
this example, incoming calls to the DID number 7328891980 on Incoming Group 17 are to be routed
to the user “Jim 1120E” at extension 258.

B 17 7328891980 gk-BX|vl<l>

Standard | Vaice Recording; Destinations |

TimeProfile Destination Fallback Extension
» Default Yalue 258 Jim 1120E N b
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5.8. ARS and Alternate Routing

While detailed coverage of ARS is beyond the scope of these Application Notes, this section includes
basic ARS screen illustration and considerations. ARS is shown here mainly to illustrate alternate routing
should the SIP Line be out of service or temporarily not responding.

Optionally, Automatic Route Selection (ARS) can be used to supplement or replace the simple 9N; short
code approach documented in Section 5.5. With ARS, secondary dial tone can be provided after the
access code, time-based routing criteria can be introduced, and alternate routing can be specified so that a
call can re-route automatically if the primary route or outgoing line group is not available. ARS also
facilitates more specific dialed telephone number matching, enabling immediate routing and alternate
treatment for different types of numbers following the access code. For example, if all local and long
distance calls should use the SIP Line, but service numbers should prefer a different outgoing line group,
ARS can be used to distinguish between the two call patterns.

To add a new ARS route, right-click ARS in the Navigation pane and select New (not shown). To view
or edit an existing ARS route, expand ARS in the Navigation pane and select a route name.

The following screen shows an example ARS configuration for the route named 50: Main. The In
Service parameter refers to the ARS form itself, not the Line Groups that may be referenced in the form.
If the In Service box is un-checked, calls are routed to the ARS route name specified in the Out of
Service Route parameter. IP Office short codes may also be defined to allow an ARS route to be
disabled or enabled from a telephone. The configurable provisioning of an Out of Service Route and the
means to manually activate the Out of Service Route can be helpful for scheduled maintenance or other
known service-affecting events for the primary route.
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& Extension (16) Dial Delay Time |System Default (4) 3| Check User Call Barring
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Assuming the primary route is in-service, the number passed from the short code used to access ARS
(e.g., 8N; in Section 5.5) can be further analyzed to direct the call to a specific Line Group ID. Per the
example screen above, if the user dialed 8-911, the call would be directed to Line Group O to be sent out
to the local area emergency response center (note that a short code 911 can also be configured to send the
emergency call out when the user simply dials 911); if the user dialed 8 + any other number, the call
would be directed to Line Group 17 as configured in Section 5.4.5. If the primary route cannot be used,
the call can automatically route to the route name specified in the Alternate Route field in the lower
right of the screen (51: Backup). Since alternate routing is considered a privilege not available to all
callers, IP Office can control access to the alternate route by comparing the calling user’s priority,
configured in the User tab of individual users, to the value in the Alternate Route Priority Level field.

5.9. SIP Options

Avaya IP Office sends SIP OPTIONS messages periodically to determine if the SIP connection is
active. By default, Avaya IP Office Release 9.0 sends out OPTIONS every 300 seconds. The rate at
which the messages are sent is determined by the combination of the Binding Refresh Time (in
seconds) set on the Network Topology tab in Section 5.2.1 and the SIP_OPTIONS_PERIOD
parameter (in minutes) that can be set on the Source Number tab of the noUser user. The
OPTIONS period is determined in the following manner:

e To use the default value, set Binding Refresh Time to 0 or 300. OPTIONS will
be sent at the 300 second frequency.

e To establish a period of less than 300 seconds, do not define the SIP_OPTIONS_PERIOD
parameter and set the Binding Refresh Time to a value less than 300 seconds. The
OPTIONS message period will be equal to the Binding Refresh Time setting.

e To establish a period greater than 300 seconds, a SIP_OPTIONS_PERIOD parameter
must be defined. The Binding Refresh Time must be set to a value greater than 300
seconds. The OPTIONS message period will be the smaller of the Binding Refresh Time
and the SIP_OPTIONS_PERIOD settings.

To configure the SIP_OPTIONS_PERIOD parameter, navigate to User = noUser in the
Navigation Pane. Select the Source Numbers tab in the Details Pane. Click the Add button.
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At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_OPTIONS_PERIOD=X, where X is the desired value in minutes. Click OK.

Mew Source Mumber

Source Mumber :-SIP_OF‘TIONS_PERIOD=6

The SIP_OPTIONS_PERIOD parameter will appear in the list of Source Numbers as shown
below. For the compliance test, an OPTIONS period of 60 seconds was desired. The Binding

Refresh Time was set to 60 seconds on the Network Topology tab in Section 5.2.1. There was no
need to define SIP_OPTIONS_PERIOD.

NoUser: * s AR i S B I

Menu Programming | Mobility | Group Membership | Announcements | SIP || Personal Directary

| User | Woicemail | DN || Shart Codesi Source Mumbers ;Telephnnv Farwarding | Dial In | Yoice Recording | Button Programming |

| SIP_OPTIONS _PERICOD=6
Remove

Edit. ..
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5.10. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected, based on the nature of the
configuration changes made since the last save. Note that clicking OK may cause a service

disruption. Click OK to proceed.

Save Configuration

IF Office Settings

(%) Merge
(3 Immediate
) When Free

) Timed

Reboot Time

Zall Barring

Jersey Ciky

Configuration Rebook Mode

| o

l [ Cancel

/|

Help ]

6. Broadvox SIP Trunking Configuration

Broadvox is responsible for the configuration of its SIP Trunking service. The customer will need to
provide the IP address used to reach the Avaya IP Office at the business site. Broadvox will provide
the customer the necessary information to configure the Avaya IP Office SIP connection to

Broadvox including:

¢ Network edge IP addresses of the Broadvox SIP Trunking service.
e Transport and port for the Broadvox SIP Trunking connection to the Avaya IP Office at the

business site.

e DID numbers to assign to users at the business site.

e Supported codecs and their preference order.
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7. Verification Steps

This section provides verification steps that may be performed in the field to verify that the solution
is configured properly.

7.1. System Status

Use the Avaya IP Office System Status application to verify the SIP Line channels state and to check
alarms:

e Launch the application from Start <> Programs -> IP Office - System Status on the
Avaya IP Office Manager PC. Select the SIP line under Trunks from the left pane. On the
Status tab in the right pane, verify the Current State is Idle for channels where no active
calls are currently in session; the state should be Connected for channels engaged in active
calls.

Avaya IP Office System Status - Jersey City (10.32.128.30) - IP500 ¥2 9.0.0.0 build 829 FEX

IP Office System Status
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e Select the Alarms tab and verify that no alarms are active on the SIP line.

Status | Ukilization Summary Alarms

Alarms for Line: 17 SIP 192.168.96.231

Last Date OF Error CiCourrences Error Descripkion
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7.2. Monitor

The Monitor application can be used to monitor and troubleshoot Avaya IP Office. Monitor can be
accessed from Start = Programs > IP Office = Monitor on the Avaya IP Office Manager PC.
The application allows the monitored information to be customized. To customize, select Filters -
Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring. In this example,
Standard SIP Events and the SIP Rx and SIP Tx boxes are checked.

All Settings E|
T1 | WPN | Wi ] SCN ] Jade ]
4TM | Cal | DTE | EConf | FrameRelay | GOD | H323 | Inteface |

IS0M ] Key;’Lamp] Direu:tu:ur_l,l] hedia ] PFF ] Rz ] Fh:uuting] Services AP lSystem]
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WV Sip |Standard v| [~ STUH [ SIP Dect
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[~ 5IF ReasOpt B [~ 5IP Misz Bx

[~ SIF Rea/Opt Tx [ SIP Misc Tx

[~ SIFCalRx [ Crn Motify B

: [ Cn Motify Tx
[ SipBx IF Filter [finn. nnnninn. ninn|
v SipTx |
Default All|  Clear All Tab Clear 4l | Tab Set Al | 0K, | e |
S oere | rrane | Select File |
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8. Conclusion

The Broadvox SIP Trunking service passed compliance testing. These Application Notes describe
the procedures required to configure the connectivity between Avaya IP Office R9.0 and Broadvox
SIP Trunking as shown in Figure 1. Test results and observations are noted in Section 2.2.

9. Additional References
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[5] Avaya IP Office Manager Release 9.0, Document number15-601011 Issue 9.01, September
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[7] Avaya IP Office 9.0 Using IP Office System Monitor, Document Number 15-601019, Issue 05c,
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[8] Avaya IP Office 9.0 H.323 Telephone Installation, Document Number 15-601046, Issue 18b,
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[9] Avaya IP Office 9.0 SIP Extension Installation, Issue 3c, August 2013.

Additional IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/.

Product documentation for the Broadvox SIP Trunking is available from Broadvox. See Section 2.3
on how to contact Broadvox.
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